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PREFACE

Chairman
        Sindh Textbook Board

 The century we have stepped in, is the century of Science and technology. The modern 
disciplines of Technology are strongly influencing not only all the branches of science but each 
and every aspect of human life.

 To keep the students abreast with the recent knowledge; it is must that the curricula at all the 
levels be updated. Moreover regularly by introducing the rapid and multidirectional development 
taking place in all the branches of  Science.

 The recent book of Computer Education for Class VII has been written in this preview and in 
accordance with the revised curriculum. Prepared by Ministry of Education, Govt of Sindh. 
Reviewed by independent team of Directorate of Curriculum Assessment and Research, Jamshoro 
Sindh. Keeping in view the importance of Computer Science, the topics have been revised and re-
written according to the need of the time.

 Among the new editions the introductory paragraphs, information boxes, summaries and a 
variety of extensive exercises have been included. Which I think will not only develop the interest 
but also add a lot to the utility of the book.

 The Sind Textbook Board has taken great pains and incurred expenditure in publishing this 
book inspite to its limitations. A textbook is indeed not the last word and there is always room for 
improvement. While the authors have tried their level best to make the most suitable presentation, 
both in terms of concept and treatment. There may still have some deficiencies and omissions. 
Learned teachers and worthy students are therefore requested to be kind enough to point out the 
short comings of the text or pictures and to communicate their suggestions and objections for the 
improvement of the next edition of this book.

 In the end, I am thankful to our Authors, Editors and Subject specialist of Board for their 
relentless service rendered for the cause of education.
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Chapter 111

After the completion of this unit students will be able to:

Student Learning Outcomes:
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Technologies

Artificial
Intelligence 

Open Source
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Cloud
Computing

Robotics
3D and

Holographic
Imaging

Virtual
Reality

Computer
Assisted

translation
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This unit covers the basic concept of emerging technologies such as ( Airtifical 
Intellegence, Robotics, biometrics and etc). This unit also gives a brief overview of the 
progression in computing technologies , different types of I/O ports and various 
peripheral devices.

Emerging technologies are new ideas still growing. They are like baby 
technologies. These new tools can:

· Solve big problems (like cleaning dirty water).
· Make new jobs (like robot helpers).
· Make life better (like smart watches that tell time and health).

Examples: Artificial Intelligence (AI), robots, Virtual Reality (VR) glasses, and cloud 
storage. A caller uses voice assistants (e.g., Siri, Google Assistant) on phones is an 
example of every day usage. Figure 1.1 shows some of emerging technologies.
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Artificial  Intel l igence (AI)  helps 
computers think and learn like people. AI lets 
machines:

· Understand what a person says.
· Learn from mistakes.
· Choose the best action.

Examples: 1) Self-driving cars that drive without 
a person (shown figure 1.2), 
2) ChatGPT and Gemini that answer questions. 
Asking asking Siri or Google for help is AI use in 
every day life.

Robotics is a new technology. It uses programming and sensors. These help 
machines see and feel what is around them. The machines can choose what to do. They 
follow instructions like a smart robot toy. 

Robots are used in many places, for example:
1)  In car factories to build cars fast (as shown in Figure 1.3) 
2)   In space to do simple jobs again and again 
3)  In dangerous areas so people stay safe 

Example: A robot vacuum cleaner at home sweeps the floor by itself.

The ward Artificial Intelligence was first used by John McCarthy in 1956. 
He is also known as the “Father of AI” 
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Biometrics comes from two 
words: "Bios" = life and "Metric" = 
measure. It means measuring parts 
of human body to know who is the 
person. It keeps things safe — only 
authentic person can open.

Examples of body parts 
used: 1) Fingerprint, 2) Face, 3) 
Eyes (iris), and 4) Voice.

Biometric is used in daily 
life for several purposes (see Figure 
1.4). For instance: 1) Unlock 
mobile phone with face or finger, 2) 
Mark attendance in school with a 
finger scan.

Voice

Iris

Face authentication 

Fingerprints 

Biometrics

CAT means Computer-Assisted 
Translation. It is a helper tool for people 
who change words from one language to 
another.
What CAT does:

· Helps write the new words.
· Saves old translations to use again.
· Makes work faster.

A real person still thinks and 
chooses the best words. The computer just 
helps speed things up.
Famous CAT tools: 
 Omega T, BasicCAT and Virtaal
Example: A teacher uses CAT to quickly 
translate an English story into Sindhi.

Figure 1.5 shows the use of 
computer-assisted translation

� د�

Virtual Reality (VR) makes a virtual (artifical) world that feels real. Person wears 
special glasses or a headset (see Figure 1.6). It feels like person is inside the game or place.
Example: Ali can walk in old Mohenjo-daro! Sara can see the streets, houses, and shops 
from long ago. It makes person to feel as he/she is really there.
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Where VR is used:
· Learning in school
· Training (like flying a plane)
· Games and fun
· Business meetings in a virtual room

H o l o g r a m s  a r e  3 D 
pictures in the air. A person can 
walk around and see them from 
all sides. They use light or laser 
to shine and look real.
Example: 
 Draw a dress on paper or 
computer. Use a hologram app. 
Watch the dress float in the air 
like magic (see Figure 1.7).

 3D Design means making things on a computer. These things have height, width, 
and depth  just like real objects.
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The teacher divides the class into groups, and each group will look into their homes 
and school to find examples of common emerging technologies(smartphones, 
computers, CCTV cameras) and each group makes a list of these examples.

Cloud Computing means 
using the internet to get:

· Storage space
· Power to run apps
· Ready-made software

A person does not need big 
machines at home. He/She just needs 
to connect to the internet and use it. A 
person may have to pay only for what 
he/she uses like website hosting. 
There are some free cloud services, 
Examples:

· Save photos in Google Photos
· Save homework in Google 

Drive
· Save games in OneDrive

Open them from any phone, 
tablet, or computer! No need for USB 
or hard disk. It's easy, safe, and cheap!

Open Source Software means 
anyone can see and change its code. A 
person does not need permission from 
the owner.
Examples:

· Firefox – a free web browser
· Java – helps games and apps run
· Linux – a free computer system

It is like a recipe book everyone 
can read and improve. 

6 
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1.2.1  Progression in Communication Technology
               ( Landline to Smartphones )

Technological progress means making better and faster ways to build things. It 
helps work, talk, and learn in new ways.

Over time, people have improved tools. This has changed everything in daily life.
Two big areas, which are commonly used everyday:

1. Communication – like phones and video calls
2. Computing – like computers and apps.

Example: Old phones were used to male only calls. Now, smartphones do photos, games, 
and homework.

This section presents technological progress in communication technology 
(Landline to Smartphones).

Alexander Graham Bell invented the telephone in 1876.
At first:

· It was only for voice calls.
· It used wires to connect.
· Person could not move it.
· person had to stay close to talk.

Example: A phone at home on the wall or Table Perosn has to sit near to phone, no 
walking around. Now phones are wireless and person can walk around while talking.

After landline phones, people made mobile phones.
Mobile phones:

· No wires needed.
· Person can carry these phones anywhere.
· Some phones had buttons to press.
· These phones allowed to play simple games.
· Person could send text messages.

Example: Old mobile phones were big. Person could play Snake game on them.

Smartphones are used to talk and share today. These smartphones are like tiny 
computers in human hand.

A person can:
· Browse the web
· Take photos and videos
· Use GPS to find places
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· Watch videos
· Make video calls
· Use apps for shopping, learning, and fun

Example: Open YouTube, take a selfie, or play a learning game — all on smartphone.

Computer progress is split into 5 generations. 
Each one got better and smaller. 

· First Generation (1940–1956):
o Used big vacuum tubes (Figure 1.10).
o Computers were huge and heavy.
o They used lots of electricity.

Example: 
A computer filled a whole room — like a giant box.

  
  
  

· Second Generation (1956–1963):
o Used transistors instead of vacuum tubes. 
o Computers became smaller.
o They worked faster.
o They used less electricity. 

Example: 
A computer now fit in a big desk — not a whole room.
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· Third Generation (1964–1971):
o Used Integrated Circuits (ICs).
o These were tiny chips with many parts inside.
o Computers got much faster.
o They became smaller too. 

Example: 
A computer now fit on a table — like a big box.

  
  
  
  

· Fourth Generation (1971–now):
o Used microprocessors.
o These are tiny chips with thousands of circuits.
o Computers became super fast.
o They got very cheap.

Example: 
Nowadays a personal computer is mostly available at home 
or school. Even a tablet or phone uses this idea.

  
  
  
  

Fifth Generation (Still in progress) wants real AI in computers. Machines will 
think and learn like people. Example: Future computers may talk, understand, and help 
just like a friend.

CPU means Central Processing Unit. It is the brain of the computer. It does all the 
thinking and work. New CPU generations are better than old ones. They are faster and 
smarter.

Companies like Intel and AMD make CPUs. Intel is very famous. Most laptops 
and desktops use Intel CPUs. Intel has made 14 generations of CPUs. Each one is stronger 
and quicker.

1st to 14th generations of Intel processors are discussed in Table 1.
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Usually, when someone buys a computer, the shop person asks: “Which 
generation do you want?”
It means: “Which Intel CPU generation?”
Example: Intel® Core™ i9-12900H
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Keyboard

Microphone

Webcam

Mouse

Printer

Let's break it down:
· Intel → The company
· Core → The family name
· i9 → Super powerful
· 12 → 12th generation
· H → High speed

Example: A 12th gen i9-H laptop is very fast.

Note:

This method applies only to Intel® 
Core™ Processors and does not apply to 
Intel® Pentium®, Intel® Celeron®, or 

Intel® Xeon®.

Peripheral devices are extra helpers for the computer. They connect to the CPU — 
the brain.

They make computer do more things. Without them, the computer is very limited.
A person can connect them with wires or wirelessly (like Bluetooth).
There are 4 main types:

1. Input Devices: Put things IN
o Keyboard, mouse, webcam

2. Output Devices:  Show things OUT
o Monitor, speaker, printer

3. Storage Devices: Save things
o USB drive, external hard disk

4. Networking Devices: Help connect
o Wi-Fi router, modem

Example: Plug in a mouse → ONE can click. Connect a printer → Print a paper.

Common Input Devices:
· Keyboard: Type letters and numbers
· Mouse: Click and point
· Webcam: Take photos or video
· Microphone: Record voice
· Scanner: Copy paper into the computer

Example: Use the keyboard to type a poem. Use 
the mouse to open a game. Use the webcam for a 
video call with friend.

Input devices help to put information INTO the computer. They send data or 
instructions.
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Left-Click
to move cursor 
or select an object

Right-Click
to open context
sensitive menus

Cable
connects to the USB
port on computer

Wheel
to scroll up or down 
the page or menu

  Keyboard is an input device. A person uses it to type:
· Letters
· Numbers
· Symbols

It has special keys too:
· Arrow keys: Move up, down, left, right
· Navigation keys: Go through menus

What a person/user can do:
· Scroll in a story
· Move the cursor (blinking line)
· Open menus in games or apps

Example: Press arrow keys to move in a game.

Mouse is an input device. It helps to control the computer. It has buttons and 
scroller (see Figure 1.15).
5 things a mouse can do:

1. Select - Click on a picture
2. Navigate - Open menus
3. Move cursor - Point to words
4. Drag and drop - Move icons
5. Scroll - Go up and down pages

How it connects:
· With a wire (plugged in)
· Or wirelessly (Bluetooth)

Example: Use the mouse to drag a photo into a folder. Scroll to read a long story.



Unit 1: ICT Fundamentals

13

 Webcam is an input device. It takes pictures or videos. It turns them into digital 
files with software. Nowadays, it is integrated in laoptops (see Figure 1.16).
How it connects:

1. With a USB cable
2. Or built inside the computer/laptop

What a person uses it for:
· Chatting with friends
· Live streaming games
· Recording videos
· Video calls in class

Example: Turn on the webcam and wave to friend on a video call.

 Scanner is an input device. It uses light to copy things.
 It turns paper into digital files. This keeps them safe and easy to find.
Common Scanners:

1. Barcode Scanner
o Used in shops
o Scans price tags fast
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2. Optical Scanner
o Used in fax machines
o Copies pictures and drawings

3. Flatbed Scanner
o Has a lid that opens
o Put paper inside
o Used in offices for books or photos

Example: 
 Scan drawing paper at school; Save it on the computer. Share it with teacher.

Output device is a helper. It takes information from the computer. It turns it into 
something a user can see or hear.
Common Output Devices:

· Monitor - Shows pictures and words
· Printer - Makes paper copies
· Speakers - Plays sounds and music
· Projector - Shows big images on a wall

Example: 
 Watch a video on the monitor. Print homework with the printer. Listen to a song 
with speakers.

Monitor is the main output device. It shows pictures and words on a screen.
It gets signals from the computer. A graphics card helps it understand. Then it 

displays the image or video.
Example: 
 A laptop screen is a monitor. Watch cartoons on it.
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CRT Monitor:
· Stands for Cathode Ray Tube
· It is the oldest type of computer screen
· Uses a big vacuum tube inside
· Makes pictures with electron beams

LCD Monitor:
· Stands for Liquid Crystal Display
· It is a flat screen
· Uses liquid crystals and electric signals
 Makes clear pictures

LED Monitor:
· Stands for Light Emitting Diode
· Uses tiny lights called LEDs
· It is very thin
· Uses less power
· Shows bright and real colors

OLED Monitor:
· Stands for Organic Light Emitting Diode
· Uses special glowing materials
· It is more expensive than LED
· Uses very little power
 Shows super clear and bright pictures
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Laser Printer
They use laser beam for 
printing. These printers 
are fast and cost-efficient 

Inkjet Printer
produces prints by spraying 
tiny droplets of liquid ink onto 
paper. These printers produce 
high-quality images.  

Receipt Printer
They use heat for printing. 
They are fast, quiet, and 
low-maintenance. 

Printer is a popular helper device. It prints text and pictures on paper. It makes hard 
copies from the computer.
How it connects:

· Wi-Fi - No wires (wireless)
· USB (Universal Serial Bus) cable - Plugged in

What it can print:
· Homework
· Reports
· Letters
· Photos

Example: Click Print and get drawing/letter on a paper.
There are many types of printers as  shown in Figure 1.14

Types:
· Built-in speakers  
 Inside laptops and desktops (see Figure 1.18)
· External speakers 
 Connect with USB or audio jack

What a person can use them for:
· Listen to music
· Watch movies
· Join online classes

Example: 
 Play a song or hear your teacher in a video call!

Speakers are output devices. They turn computer signals into sound.

Figure 1.18 
Laptop internal speakers
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Projector is an output device. It shows big pictures from the computer. It puts the 
image on a wall or screen. 
How it connects:

· HDMI (High-Definition Multimedia Interface) cable 
 it is used for clear video (see Figure 1.19)
· VGA (Video Graphics Array) cable - Older type

Where a person can use it:
· School - Show lessons
· Office - Meetings
· Home - Watch movies

Example: A teacher uses a projector to show a story on the big wall.

 Storage devices save and get back data. They help computers keep lots of files.
Common Storage Devices:

· USB drive 
 Small stick you plug in
· External hard drive
 Big box with cable
· SSD (solid-state drive) drive 
 Fast and inside modern computers

Example: 
 Save homework on a USB drive. Take it to school and open it there.
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USB Drive (also called pen drive) is a 
small storage tool. It plugs into the USB port of a 
computer (see Figure 1.20).
What it does:

· Saves files
· Backs up data
· Moves files from one device to another

Example: 
 Save a project on a USB drive. Take it to 
school and plug it in computer/laptop.

External Hard Drive is a portable storage 
box (See Figure 1.21). It connects to a laptop or PC 
(Personal Computer) with a USB cable.
Main Advantage:

· Gives extra space for files
· More room than the built-in drive

Example: 
 Save all photos, videos, and games. Carry 
it anywhere and plug it in computer/laptop.

SSD means Solid State Drive. It is a fast storage 
device (see Figure 1.22).
Why it's better:

· More space
· Super speed
· Uses less power

It works using special silicon chips. SSDs are 
newer and smarter than old drives.
Example: 
 Games load in seconds on a computer with SSD.
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 Network devices help computers talk to others. They share data over a network or 
the Internet.
Common Network Devices:

· Modem - Connects to the internet
· Wireless Access Point - Makes Wi-Fi
· Network Adapter Card - Lets devices join the network

Example: Use a modem to go online. Connect with Wi-Fi to share files.

Modem helps to get internet. It changes 
signals such that computers can be connected to the 
Internet (see Figure 1.24).
How it works:

· Turns computer data into phone line signals
· Turns phone signals back into computer data

 It is a translator between computer/device 
and the ISP.
Example: Plug in the modem. Open YouTube. 
Watch videos fast.

WAP means Wireless Access Point. It 
helps wireless devices connect to a wired network 
(see Figure 1.25).
Why use it:

· No cables needed
· Easy to set up
· Connects all devices in one place

Example: At home Wi-Fi router is a WAP. Phones, 
laptops, and tablets join the internet without wires.

Network Adapter Card helps computer send and 
receive data. It connects to other devices on the network.

It is fixed on the motherboard inside the 
computer.
Example: Use it to connect to Wi-Fi or play online 
games.

Without it, computer cannot be connected to the 
Internet.
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Activity Time

The teacher will make a Venn diagram on the board with two overlapping circles 
labled as “modem” and “NIC Card” respectively  then ask student to fill these circle 
with function of both devices so they can differentiate between their functions and 

find similarities .

Ports are small holes on a computer. They connect helper devices (pheripherals).
What do ports do:

· Send data from CPU to devices
· Get data from devices to CPU

Where these ports are present:
· Back of desktop computer (see figure 1.27 a)
· Side of laptop (see figure 1.27 b)

Common Ports:
· USB - For mouse, keyboard, pen drive
· HDMI - For TV or monitor
· Audio jack - For headphones
· Power port - To charge

Example: Plug mouse into a USB port. It works immediately.



Unit 1: ICT Fundamentals

21

Serial Advanced Technology Attachment (SATA) Port connects hard disks and 
SSDs (Solid State Drives) to the motherboard. It is inside the computer (see figure 1.28).
What does SATA Port do:

· Sends data from CPU to disk
· Gets data from disk to CPU

Example: A game and photos load fast because of SATA.

PCI (Peripheral Component Interconnect) Port is used in desktop PCs. It is a fast 
slot on the motherboard (see figure 1.29).
PCI Port connects extra cards like:

Graphics card (for games)  Sound card  Network card
PCI-e is a newer and faster version. It replaces old PCI. It is also a slot inside the 

computer.
Example: A gaming PC has a graphics card in a PCI-e slot. It makes games look smooth 
and colorful.
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 A serial port sends data one bit at a time in order. It 
has 9-pin or 25-pin connectors (see figure 1.30). It is also 
called a COM port (for example, COM1 or COM2).
Its uses:

· Connecting modems
· Connecting microphones
· Connecting older printers

Example: In old computers, a mouse or modem was 
connected using a serial port.
Note: Today, USB ports are used instead of serial ports.

 A parallel port sends 8 bits (one byte) at a time. It is 
faster than a serial port. It is also called a printer port (see 
figure 1.31).
Its uses:

· Connecting printers
· Connecting scanners

Example: Old computers used parallel ports to attach printers.
Note: Today, USB ports have replaced parallel ports.

 USB stands for Universal Serial Bus. The first non-commercial USB port came 
out in 1994.

Its uses:
· Connect mouse, keyboard, printer, 

scanner, external hard disk
· Transfer data quickly

Its connector:
· The oval-shaped plug a person puts 

into phones or computers.
Types of USB Ports (see figure 1.32):

· Type-A – Common rectangle shape
· Type-B – Square with curves
· Type-C – Small, reversible
· Micro USB – Tiny, used in old phones

Example: Plug a pen drive into a Type-A port 
to copy homework.

Figure 1.32 shows different USB ports
 with their connectors

USB Type-A
USB Type-B

USB Type-C Micro USB
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HDMI means High-Definition 
Multimedia Interface (see figure 1.33). It 
connects computer to TV, monitor, or 
projector. It also sends clear video and 
sound using one cable.
Its uses:

· Extend laptop screen
· Mirror display
· Play movies or give presentations

Example: Plug HDMI cable from laptop to 
TV. Watch a game or video on a big screen.
Note: One thin cable does everything.

Ethernet port (also known as an RJ45 port)  helps to plug in an Ethernet cable (also 
called a network cable). It connects computer to a network or Wi-Fi router (see figure 
1.34). It is a small rectangular hole with eight metal contacts. It is, usually, labeled with a 
network icon or “LAN” on backside of desktop computer and side of laptop.
Its benefits:

· More stable than Wi-Fi
· Usually faster internet

Example: Plug cable into Ethernet port; Play online games using the Internet. 
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Terms to Remember

Summary
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EXERCISE
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Instructions for Teachers

Class Activity
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27

Chapter 222

After the completion of this unit students will be able to:

Student Learning Outcomes:

 

 Understand basics of Word processing using MS Word
Explore functions of MS Word
Explore functions of Presentation Software using MS Power Point
Understand the basics of electronic mailing (Email)
Demonstrate usage of Email
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 In this chapter, students will learn three important digital skills used in schools and 
daily life. Students will learn how to use MS Word to type assignments, format text and 
print documents. Students will use MS PowerPoint to create slideshows with text, 
pictures and animations. Students will also use Email to send and receive messages safely 
over the internet.

Education Workplace Home

Students type essays, 
a s s ignmen t s ,  and 
projects.

Teachers create lesson 
plans, worksheets and 
projects. 

 Word processing is a computerized method of 
writing and managing documents. In today's world, it is an e
ssential digital skill used in daily life. Students use word p
rocessors on computers, tablets and mobile phones to c
reate and edit documents quickly and easily. MS Word is t
he most common word processor. Following are the c
ommon uses of word processing:

O ffi c e s  u s e  w o r d 
processing for writing 
emails, reports and 
business letters.

Professionals create 
d o c u m e n t s  l i k e 
invoices ,  meet ing 
notes and forms.

People write letters, 
resumes, shopping 
l i s t s  a n d  e v e n t 
invitations.
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 The other common word processing programs are Microsoft Word, Google Doc 
and WPS Office.

 Microsoft Word is a word processor developed by 
Microsoft Corporation. It provides advanced tools to format 
and edit documents such as letters, stories, homework and 
reports. Users can change font, insert pictures, check spelling 
and print documents. It is one of the most widely used word 
processing programs in schools and offices.

· Make sure MS Word is already installed on the computer.Figure  .2 Open MS 
Word

· Start Microsoft Word: Click on windows start button and type “Word” in search 
box. Word app icon will appear, click on it or click open option showing as in 
below figure.
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1. Document Title
This shows the name of the current document. It appears at the top of the MS Word 
window.

2. Action Tabs
These tabs appear on the Ribbon only when a specific object is selected. They are 
also called Contextual Tabs because they show tools related to the selected object.

Common Action Tabs:
· Table Tools

o Appears when students insert or select a table
o Provides two tabs: Design and Layout

· Picture Tools
o Appears when students select a picture
o Provides the Format tab to crop, add borders, change brightness, or apply styles
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· Drawing Tools
o Appears when students select a shape, WordArt, or a text box
o Provides the Format tab to edit fill, outline, and effects.

3.  Ribbon: The Ribbon is the large toolbar at the top of the window. It has tabs such 
as Home, Insert, Draw, Design, and Layout. Each tab has tools that help students 
work with the document.

 There are two parts in Ribbon: Groups and Command buttons.
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 The Save command keeps the changes in the current file. It is used when the file 
has already been saved before and students only want to update their work. It keeps the 
same name and the same folder and is a quick way to save while editing. The shortcut for 
Save is Ctrl + S.
 The Save As command creates a new file with the same content. It is used when 
students want to make a copy with a different name or location. Save As allows choosing 
another folder or drive and can also save the file in another format such as PDF or DOC. 
The shortcut for Save As is Alt + F + A.

This method applies only to Intel® Core™ Processors and does not apply to Intel® 
Pentium®, Intel® Celeron®, or Intel® Xeon®.

Tips

Default file extension of MS Word is .docx, we can change it to another format by 
Saving As the document from File menu. 
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a. Select the text “My Favorite Animal” go to Style group and click on 
Heading.

b. Select the heading and center align it using the Paragraph group or press 
Ctrl + E..

Write a short paragraph about animal, where it lives, eats and why you like it.
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Tables: A table is a grid of rows and columns. It helps to organize information 
neatly in a document. To insert a table, click Table in the Tables group and move 
the mouse over the boxes to choose the number of rows and columns.
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This method applies only to Intel® Core™ Processors and does not apply to Intel® 
Pentium®, Intel® Celeron®, or Intel® Xeon®.

Note:
Teacher should demonstrate how to save a copy of document with different file 

format option.
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This method applies only to Intel® Core™ Processors and does not apply to Intel® 
Pentium®, Intel® Celeron®, or Intel® Xeon®.

Tips

 A presentation enables students to share 
information in a clear and attractive way. When 
students give a report or explain a project, a good 
presentation helps the audience follow every idea 
without effort.
 A presentation is a series of slides that appear 
one after another on the screen. Each slide carries one 
main idea. Text, pictures, sounds, and short video clips 
work together. These elements are called multimedia.
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Multimedia helps the audience learn faster because:
· Text states the facts.
· Pictures show the meaning at a glance.
· Sounds keep attention alive.
· Videos bring real examples to the classroom.

Five programs are widely used to create presentations:
1. Microsoft PowerPoint: the standard tool in 

schools.
2. Google Slides: free and works on any device 

with internet.
3. Apple Keynote: produces smooth designs on Apple computers.
4. Prezi: displays content on one large zooming canvas.
5. Canva: offers ready-made templates and free images.

 Microsoft PowerPoint is the presentation program that comes with the Microsoft 
Office suite. Students, teachers, and office workers use it to create presentations for 
lessons, projects, and meetings. The program is simple to learn because its tabs and 
commands work in the same way as Microsoft Word.
Main Features:

· Slides – individual pages that build the show
· Layouts – ready designs for titles, pictures, or charts
· Themes – sets of colours and fonts that give a neat look
· Transitions – smooth changes from one slide to the next
· Animations – gentle movements that make objects appear

Most Common Ribbon Tabs:
1. Home: new slides, copy, 

paste, bold, bullets
2. Insert: pictures, shapes, 

charts, videos
3. Design: choose a theme or 

change colours
4. Transitions: pick Fade, 

Push, or Wipe
5. Animations: make text 

fly in or spin
6. Slide Show: start with F5, 

move with arrow keys
7. View:  see thumbnail 

slides on the left
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The PowerPoint Window
When the program opens, three areas appear:

1. Ribbon: rows of tabs at the top
2. Slide Pane: the big white slide in the center
3. Thumbnail Pane: small pictures of every slide on the left

 Every presentation in Microsoft PowerPoint is built from individual slides. A slide 
is a single page that holds titles, pictures, bullet points, or charts.
Seven Steps to Build a Presentation

1. Open PowerPoint Double-click the orange PowerPoint icon on the desktop. 
Choose Blank Presentation. A fresh title slide appears.

2. Add the First Slide (Title Slide) Click inside the top box → type “Saving the Snow 
Leopard”. Click the bottom box → type your name, class 7-B, and today's date.

3. Insert New Slides
· Method 1: Home tab ► New Slide ► pick a layout.
· Method 2: Press Ctrl + M (fastest way).
· Method 3: Right-click any thumbnail on the left pane → New Slide.

4. Choose the Right Layout Common layouts: 
· Title and Content: one picture + bullets
· Two Content: picture on left, bullets on right
· Blank: start from scratch
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5. Duplicate or Delete Slides Right-click a thumbnail:
· Duplicate Slide – makes an exact copy
· Delete Slide – removes it forever

6. Rearrange Slides: In the left pane, drag any thumbnail up or down. Drop it in the 
new place. The show order changes instantly.

7. Save Early, Save Often:
· File ► Save As ► Desktop ► “Snow_Leopard_YourName.pptx” ► Save.
· Press Ctrl + S every five minutes.
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 A hyperlink in PowerPoint is a clickable text, shape, image, or object that moves 
the screen to another location. When a student clicks the blue underlined word or picture, 
the computer jumps instantly to another slide, another file, or a website.
Two Kinds of Hyperlinks

1. Internal: jumps inside the same presentation
2. External: opens a webpage on the internet

Internal Hyperlink – Jump to Any Slide
1. Type the word “Facts” on Slide 2.
2. Select the word Facts.
3. Right-click → Link (or press Ctrl + K).
4. In the box, click Place in This Document.
5. Choose Slide 5. Amazing Facts.
6. Click OK. The word turns blue and underlined.

Test: Press F5 → click Facts → you land on Slide 5!
External Hyperlink – Open a Website

1. On Slide 3 type “Visit STBB”.
2. Select the words Visit STBB.
3. Right-click → Link.
4. Click Existing File or Web Page.
5. In the Address box type: https://stbb.edu.pk/
6. Click OK.

Test: Run the show → click the link → the STBB website opens in the browser.

https://stbb.edu.pk/
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 In ICT, an animation is a short movement that brings an object onto the slide. 
When students set the Start option to On Click, the object stays hidden until the presenter 
presses the mouse or spacebar. This keeps the audience focused and makes every point 
feel like a surprise reveal.
Why “Appear on Click” is Powerful

· Slide looks clean at first
· Students control the exact second each fact arrives
· Used in every professional TED Talk and school science fair

Step-by-Step: Make a Picture Appear on Click
1. Insert the Object: Slide 3 → Insert tab → Pictures → choose a photo of the 

Karakoram Highway → Insert. Resize it to half the slide.
2. Open the Animation Tools: Click the picture once. Animations tab lights up at the 

top.
3. Choose an Entrance Effect: In the Animation group, click Fade (gentle) or Fly In 

(exciting). A small number “1” appears on the picture.
4. Make it Wait for Your Click: Look at the right side → Animation Pane → click the 

small arrow to open it. Click the words “Picture 1” in the list. In the Start box, 
change With Previous to On Click. A tiny mouse icon appears – success!

5. Add More Objects (up to 5): Repeat for a text box (“2,300 km long”) and a star 
shape. Each gets its own number (2, 3, 4).

6. Test the Magic: Press F5. Slide 3 is blank except the title. Click once → picture 
fades in. Click again → length appears. Click again → star spins in.
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 Speaker Notes are private reminders that only the presenter sees. They sit safely 
below each slide and never appear to the audience during the slide show. Users use them to 
remember exact numbers, jokes, or “slow down here” hints.
Why Top Users Always Add Notes

· Never forget the population of Gilgit (1.6 million)
· Read the exact quote from Allama Iqbal
· Stay calm when the class asks a surprise question

Three Ways to Open the Notes Area
Way 1: Notes Button (fastest) View tab → Notes button. A wide grey box opens under the 

slide.
Way 2: Notes Page (full-page view) View tab → Notes Page. Each page shows one slide + 

a big notes box. Perfect for printing.
Way 3: Normal View (everyday) Look at the bottom of the window. A thin bar says “Click 

to add notes”. Click it → type.
Step-by-Step: Add Secret Notes

1. Open your “City_2.4.1.pptx”.
2. Go to Slide 3.
3. Click View → Notes.
4. In the grey box type: “Speak slowly – 30 seconds silence after the picture” 

“Population = 2.2 million (2023 census)” “Ask class: Who has visited?”
5. Slide 5 → type: “Smile here! Tell the funny bus story.”
6. Press Ctrl + S to save.
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See Notes While Presenting
1. Connect the laptop to the projector.
2. Press F5.
3. On the laptop screen choose Use Presenter View. 

o Big slide → shows on projector
o Timer + notes → shows only on laptop

 A slideshow is the live performance of your slides. An executable file (.ppsx) is a 
magic version that starts the show the moment anyone double-clicks it—no menus, no 
editing, just pure presentation.
Part A – Start the Slideshow (30 seconds)

1. Open your “Dolphin_YourName.pptx”.
2. Slide Show tab → From Beginning (or press F5).
3. The first slide fills the screen.
4. Left-click or press Spacebar → next slide.
5. Press Esc → back to normal view.

Running the Show & Making It Executable:

 Presenter View (laptop + projector) Connect the projector → Slide Show tab → 
tick Use Presenter View.

· Projector shows the big slide.
· Laptop shows the slide + your Speaker Notes + a timer.
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Part B: Turn It into an Executable Show
1. File → Save As.
2. Folder: Desktop
3. File name: “Dolphin_Show”
4. Save as type → choose PowerPoint Show (.ppsx)
5. Save.

One-Click Magic
Double-click “Dolphin_Show.ppsx”

· Slideshow starts instantly
· No Ribbon, no thumbnails
· Perfect for the science fair laptop!
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Activity: My Dream Vacation
 A Complete 8-Step Project for Grade 7
 This ready-to-teach activity turns every student into a PowerPoint expert in one 
40-minute lab period. Follow the numbered steps exactly. Tick each box when finished.
Step 1 Open PowerPoint

  Double-click the orange PowerPoint icon.
  Click Blank Presentation.

Step 2 Build Exactly 4 Slides
Slide 1 – Title Slide 
  Top box: “My Dream Vacation” (font size 44)
  Bottom box: Ali Khan – Class 7-B – 05 Nov 2025
Slide 2 – About the Place 
  Title: “Maldives – Islands in the Sky” 
  Type 3 short sentences (font size 28):  1 200 tiny islands  Water so clear you see 
fish from the plane  30 °C every day
Slide 3 – Things to Do 
  Title: “Top 5 Adventures” 
  Insert 3 pictures (Insert → Pictures → This Device) 
  Under each picture type one line:  
  Snorkel with turtles  
  Night fishing under stars  
  Walk on a sandbank
Slide 4 – Summary 
  Title: “Why I Must Go” 
  One big sentence: “Blue water + kind people = perfect memories!”

Step 3 Add Design & Transitions
  Design tab → choose “Ocean” theme. 
  Transitions tab → select all slides (Ctrl + A) → Fade → Duration 01.00.

Step 4 Add Animations
  Slide 2: select the 3 sentences → Animations → Wipe.
  Slide 3: select each picture → Animations → Zoom → Start: On Click.

Step 5 Insert Images
  Every slide must have at least one picture.
  Resize by dragging corners (hold Shift for perfect shape).

Step 6 Add Your Name in the Footer
  Insert → Header & Footer 
  Tick Footer → type “Ali Khan – 7-B” 
  Click Apply to All.

Step 7 Preview the Magic
  Press F5. 
  Click slowly through every animation.
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  Press Esc to stop.
Step 8 Save Two Files

  File → Save As → Desktop 
 Name: MyDreamVacation.pptx → Save 
 Change “Save as type” → PowerPoint Show (*.ppsx) 
 Name: MyDreamVacation.ppsx → Save

Bonus Test 
  Close PowerPoint. 
  Double-click the .ppsx file on Desktop. 
  Your show starts instantly!

 Email (electronic mail) is a fast 
and easy way to communicate over 
Internet. You can use a computer, tablet, 
or phone to write messages and attach 
files such as documents, pictures, audio, 
or videos. 

 An email platform is a program, or web-based service (website), or app that 
allows to send, receive, and manage your emails. These platforms often have extra 
features like such as saving contacts, blocking unwanted mail, using calendars, storing 
files online (cloud storage), and accessing email on a phone or tablet.
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Key Terminologies/Key Terms:

 An Email Address is a unique ID that allows a person to send and receive emails. 
Just like regular email mail needs a sender and receiver address to send message properly. 
Components/Parts of Email address:
Structure:  username@domain.com

· Username: The name of user (e.g., abc123)
· @: This @ (at a rate of) symbol is used for connect the username to the domain. It's 

also known as separator. 
· Domain: The service provider (e.g., gmail.com, yahoo.com, outlook.com)

  A Password is a secret combination of characters, numbers and alphabets used to 
secure an email account. It protects user data and ensures that only you can use your email. 
For strong password user can use a mix of letters, numbers and symbols such as @ # $.
Reminder:  Never share password with anyone.
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Sign In to Gmail
User can Sign In into Gmail account by steps as follows:
1. Open browser and go to www.gmail.com
2. Type email address (e.g. aliraza@gmail.com) and click next
3. Type password carefully and click next
4. You're Signed In! now user can see inbox. User can now read, write, and manage 

emails.
Sign out from Gmail: 

User can Sign Out into Gmail account by steps as follows:
1. Open Gmail and make sure you're signed in.
2. In the top-right corner, cl ick your profile picture or initial.
3. Click Sign out or sign out of all accounts.
4. You're signed out. If you want, you can close the browser tab or window.

http://www.gmail.com
mailto:aliraza@gmail.com
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 Compose an email means to write an email. First, login into Gmail with username 
and password. Please follow the steps:

1. Go to Gmail.com and enter username/phone number and password to own inbox.
2. Click on Compose button to start composing email as shown in following image.

3. After clicking Compose button. 
A new message window will 
appear at the bottom-right (or as a 
panel).

4. To: field is for main recipient 
address.

5. Click “Cc” or “Bcc” (shown near 
To field) to expand those optional 
fields 

6. Subject: line appears under 
recipient fields.

7. Message body: below subject, 
with formatting options and 
attachment icons at bottom. Type 
message content. 

8. Toolbar includes icons for 
formatting fonts, color, underline etc., Attach files (Paper Clip icon     ) images, 
documents, audio and video etc. insert links icon, and google Drive icon used for 
insert files from google drive, etc.

9. Click send to send email. 



Unit 2: Digital Skills

71

CC (Carbon Copy): For people who need to be informed. 

BCC (Blind Copy): For privacy, others will not see who is in BCC.
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Folders: Emails are arranged in different folders to keep 
them organized. Some important folders are:

· Inbox: This is where all the new or received 
emails appear by default.

· Sent: This folder stores all the emails that are 
sent.

· Trash: Deleted emails go to this folder. You could 
recover emails from here if deleted by mistake.

· Junk/Spam: Unwanted or suspicious emails are 
automatically moved to this folder.

· Contact: A saved email address with details 
about a person or organization stor in your email 
account. A contact can include a name, email 
address, phone number, and other information. 

Labels: Labels help to organize, group, and filter emails 
without moving them to inbox. A single email can have 
multiple labels. 
Create a New Label:

1. Open Gmail
2. Scroll down left sidebar
3. Click “+” on Labels option or “More” → “Create 

new label”
4. Type name (e.g., “Assignments”, “Projects”, 

“Family”)
5. Click Create.

Apply Label to Email
1. From Inbox
2. Check box next to email(s)

3. Click Label icon   ️  at the top or click 
4. Select label or create a new one
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Summary

· A Word processor is an application software for creating, editing, 
formatting and printing documents.

· Ribbon organizes Word's features in a visual, easy-to-use way so user can 
find commands faster without digging through long menus

· Headers and Footers help keep documents organized and professional by 
showing consistent information across pages.

· Microsoft PowerPoint (PPT) is a powerful, easy-to-use presentation 
graphics software program that allows to create professional-looking 
electronic slide shows. 

· PowerPoint Slide Show is created when all of presentation's slides are 
arranged in a certain order and then shown to audience in which each slide 
is displayed sequentially. 

· Hyperlink is a digital reference providing direct access to data by a user's 
clicking or tapping.

· Email is a facility to communicate messages and data through computer. It 
is an essential tool used widely in personal, professional, and academic life 
due to its speed, convenience, and ability to handle multiple formats.

· Email Address is a unique address used to send/receive emails (e.g. 
user@example.com)

· Password is a secure code to protect your email account.

· Contact is a saved person's information including their email for easy 
communication.

· Authentication means showing that someone really is the one, he/she 
claims trying to use a system, website, or service. 

mailto:user@example.com
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EXERCISE
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Class Activity

Instructions 
for Teachers
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Problem SolvingProblem Solving
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Problem Solving
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Chapter 333

After the completion of this unit students will be able to:

Student Learning Outcomes:

 

 

Solve complex problems by applying computational thinking.
Understand different steps of computational thinking to solve a complex problem.
Define algorithms and provide simple real-life examples of algorithms.
Design algorithms for complex problems.
Draw flowcharts for representing algorithms.
Understand control structures including conditions and loops.
Apply conditions and loops for designing algorithms.
Infer clear instructions to produce correct results.
Analyze different ways to solve the same problem. 
Understand and validate the algorithms to solve the problem. 
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Breaking down a 
problem into 

smaller parts which 
are easier to solve.

Identifying a given 
problem step-by-
step in a clear and 

organized way

Solving a given 
problem step-by-
step in a clear and 

organized way

Selecting the best 
solution among 
different options

Computational Thinking

Decomposition Abstraction Logical Thinking Decision Making

Thinking Problem Solution

 This chapter introduces algorithmic thinking to solve complex problems. In this 
chapter, we will learn how to think like a computer scientist by applying computational 
thinking to solve problems in a smart and organized way. This chapter also covers how to 
design algorithms and flowcharts for solving different problems using algorithmic 
notations. 

 Computational thinking helps to solve 
big problems step by step. It works like a 
computer.
Its key steps:

1. Break it down – Split big problems into 
small parts.

2. Ignore extras – Remove things that don't matter
3. Plan clearly – Make a smart step-by-step solution

Example: Planning a school trip:
 (Step 1) Pack bag, (Step 2) board bus, reach school Break: 
  Weather forecast (not needed now)Ignore:
  Step 1 → Step 2 → Done.Plan:
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 Consider a problem to organize an event 
“Clean and Green Pakistan Day”. Students will 
clean classrooms. They will plant trees. They will 
spread awareness to keep Pakistan clean.
 This is a complex problem. It needs 
computational thinking to solve it. Break it into 
small steps.

Steps of Computational Thinking:

1. Understand the Problem – What 
needs to happen? Who joins? 
When and where?

2. Break It Down – Split into parts: 
Planning, cleaning, planting, 
awareness.

3. Find Patterns – Reuse ideas, like 
group teams for all tasks.

4. Ignore Extras – Skip things not 
needed, like fancy decorations.

5. Make a Plan – Step-by-step: 
Invite people, get tools, do the 
event, check results.

 The important skills of computational thinking are 
1) Decomposition, 2) Abstraction, 3) Logical Thinking and 
4) Decision Making.

 Breaking big or complex problem into smaller manageable tasks. For example, 
organizing an even “Clean Pakistan Day”. The smaller manageable tasks may include 
following:

· prepare a task list
· register volunteer for each task
· prepare list of equipment for each task
· choose team leads
· set day and time of each event

Example Plan:

· Step 1: List supplies (brooms, seeds, posters).
· Step 2: Assign jobs (Group A cleans, Group B plants).
· Step 3: Practice speeches for awareness.
· Step 4: Hold the event and clean up.
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· Ignore things that do not help
· Focus on only important details 

Number of volunteers

Number of trees to plant

Cleaning areas (classrooms)

Date and time

Items for safety (gloves and masks)

Getting permission from school

Color of their shirts

Brand of planting tools

Shape of the dustbins

Weather next week

Brand of masks

Important (Keep) Irrelevant (Ignore)

Abstraction helps to 1) save time, 2) keep plan simple, and 3) Helps to finish task quickly.

Make a clear and simple plan. 

Abstraction means:

Event Plan: 
 Clean and Green Pakistan Day

1. Get permission
o Ask the principal to approve 

the event
2. Make volunteer groups

o Cleaning Group 
  Clean classrooms
o Planting Group
  Plant trees
o Awareness Group 
  Make and paste posters

Example: 
· Step 1: Principal says YES
· Step 2: 10 students in Cleaning Group
· Step 3: Buy 20 trees
· Step 4: Event on Friday at 8 AM

3. Arrange materials
o Brooms, gloves, saplings, paper, colors

4. Set date and time
o Friday, 8:00 AM to 12:00 PM
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 Good choices help event successful — even with problems/challenges.
Event: Clean and Green Pakistan Day

Low budget

Few volunteers

Rain coming

Choose cheap plants (like local seeds)

Join two groups into one

Move event inside or pick a new date

Challenge Faced Smart Decision

Example:
· Rain forecast? 
 Hold poster-making in the hall
· Only 5 helpers?  
 One team cleans and plants

Note:  Think fast, act smart - every problem has a fix.

Activity Time

Consider a challenging problem to arrange elections for class monitor. Apply 
computational thinking for solving this real-world problem step-by-step. You need to 

make sure that the whole process of election should be fair, simple, and well-managed.

 An algorithm is a step-by-step plan to solve a problem. It is a well-defined and 
finite sequence of instructions to solve a problem or perform a specific task. 
Everyday Life Examples:

· Following a cake recipe
· Solving a math problem step by step

Problem: 
 A customer buys Mouse at Rs. 500, Keyboard at Rs. 1200 and Watch at Rs. 800. 
Find the total amount to pay.
Algorithm (Step-by-Step):

1. Start
2. Write price of mouse = 500
3. Write price of keyboard = 1200
4. Write price of watch = 800
5. Add all prices: 500 + Algorithms 1200 + 800
6. Total = 2500
7. Stop

Total Amount: Customer pays Rs 2500.
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 A flowchart is a graphical representation of 
an algorithm. Table 3.1 shows commonly used 
symbols for drawing flowcharts along with their 
description.
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Start

Print “Input Marks of 
a Subjects”, Marks

If Marks > = 50

Stop

Print “You are Pass”

Yes
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Stop

Start

Print “Input Marks of 
a Subjects”, Marks

If Marks > = 50
Yes

No Print “You are Fail”Print “You are Pass”

No
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Start

Print “Input Marks of 
a Subjects”, Marks

Print 
“You are Fail”

If 
Marks > 80

Print 
“Grade A”

No

Print 
“Grade B”

Stop

No

Print 
“Grade C”

NoIf 
Marks > 60

If 
Marks > 50

Yes Yes Yes
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Start

Set Counter = 2

Is Counter 
< = 10?

Print Counter

Set Counter = 
Counter + 2

Stop

No

Yes
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Start

Set Counter = 1

Print 
“Long Live Pakistan”

Set Counter = 
Counter + 1

Is Counter 
< = 3?

Stop

Yes

No
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Start

Turn LED OFF

Wait for 1 second

Wait for 1 second

Turn LED ON

Repeat
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Start

Is condition 
true?

Yes
Read temperature

sensor value

Print temperature

Wait for 5 second

Stop

No

 By understanding, breaking down, and planning, you can solve any complex 
problem with a clear algorithm. 
Examples of Complex Problems:

1. Finding the shortest path to school during traffic
2. Planning a study schedule for exams
3. Sorting 100 books in the library by name
4. Programming a robot to water plants
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Robot Watering Algorithm (Example):
Problem: 
 Plants are in a straight line. Each 
has a moisture sensor. Robot must water 
only dry plants and skip wet ones.
Algorithm (Step-by-Step):

1. Start at the first plant
2. Check moisture sensor
3. If low → Pour water
4. If normal → Skip
5. Move to the next plant
6. Repeat until the last plant
7. Stop

Example Run/Execution:

Plant Moisture Action

1

2

3

4

Low

Normal

Low

Normal

Water

Skip

Water

Skip
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Start

Set PlantCounter = 1

Is PlantCounter>TotalPlants?

Read Moisture Level 
of current plant

Stop

Is Moisture Level Low?

Set PlantCounter 
= PlantCounter + 1

Set TotalPlants = N

Water Plant

No

Yes

Yes

No

 An algorithm must have clear steps. A computer follows them exactly. If steps are 
confusing, the result will be wrong.
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Imagine: Wali tells a robot to build a LEGO car. If his instructions are not clear, the robot 
may build a boat or plane instead.
Rules for Clear Algorithm Instructions

· Use simple words – Say “pick red brick” not “select crimson piece”.
· Give one step at a time – Don't mix actions.
· Be exact – Say “place 2 wheels on left side” not “add some wheels”.
· List steps in order – Step 1, Step 2, Step 3…
· Check the result – Make sure the car moves and has 4 wheels.

Example: Build a LEGO Car (Clear Steps)
1. Take a yellow base plate (4´8).
2. Attach 2 black wheels to the back.
3. Attach 2 black wheels to the front.
4. Place a red seat in the middle.
5. Add a blue steering wheel.
6. Done  Wali has a car.

Rule-1: Be Specific and Do Not Guess
Computers don't think like humans. They follow only what a person tells. They cannot 
guess.
Bad Instruction (Unclear) Example: “Make a red car.”
Problem with Bad Instruction:

1. Which part is red?
2. How much red?
3. Robot might make only wheels red or everything green!

Good Instruction (Clear) Example:
1. Take four 2´4 red LEGO bricks.
2. Attach one red 2´4 brick on top of each black 2´2 wheel base.

Result: Robot builds the correct red car body every time.

Rule-2: Break Down the Instructions into Smaller Steps
 Always try to break big tasks into smaller easy to follow tasks. For example, if 
robot has to build a LEGO car, then only instruction, “build car” is considered as too big. 
Instead, if give following instructions then it will be easier for a computer to understand.
Step-1: Take one 5´10 gray colored base plate.
Step-2: Take four black 3´3 wheel bases.
Step-3: Attach one black 3´3 wheel base to each corner of the 5´10 gray base plate.
Step-4: Take two 1´4 black axles.
Step-5: Attach one axle to the front two wheel bases and one axle to the back two wheel 

bases.
Step-6: Take four small black tires.
Step-7: Attach one tire to each end of the axles.
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Activity Time

Analyze given examples thoroughly and think why instructions in the 3rd column of 
“Unclear Instructions” are not clear.

 One problem can have many solutions. Each 
algorithm may work differently but give the same 
correct answer.
Problem: Check if a number is even or odd.
Algorithm 1: Using Division

1. Take the number
2. Divide by 2
3. If remainder = 0 → Even
4. Else → Odd

Example: Number = 8 8 ÷ 2 = 4 (remainder 0) → Even
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Algorithm 2: Using Last Digit
1. Look at the last digit
2. If it is 0, 2, 4, 6, or 8 → Even
3. Else → Odd

Example: Number = 15 Last digit = 5 → Odd
Algorithm 3: Using Bit Check (Advanced)

1. Look at the least significant bit (LSB)
2. If LSB = 0 → Even
3. If LSB = 1 → Odd

Example: Number = 10 (Binary: 1010) LSB = 0 → Even

Number

7 7÷2 = 3 rem 1 → 
Odd

Last digit 7 →
Odd

LSB = 1 → Odd

Algorithm 1 Algorithm 2 Algorithm 3

12
12÷2 = 6 rem 0 
→ Even

Last digit 2 → 
Even

LSB = 0 → Even

Odd

Final Answer

Even

Remainder check method: 
 This method divides given number by 2 and then checks for remainder value. If 
the remainder value is zero means the number is even otherwise, the number is odd.

Look last digit method: 
 This method is a simple way to check if a number is even or odd by only looking at 
its last digit. If the last digit is 0, 2, 4, 8, then the number is even. Otherwise, if the last digit 
is 1, 3, 5, 7, and 9, then it is an odd number.
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 Writing an algorithm is not enough. Person must understand it and check if it 
really works.
1. Understanding an Algorithm
It means:

· Know what each step does
· Know why the step is needed
· Know how it helps solve the problem

If a person does not understand then he/she may miss details and make mistakes.
2. Validating an Algorithm
It means:

· Test if it gives correct results
· Try it with different inputs
· See if output is right

If wrong → Fix the steps.
Key Terms in Validation

Input the algorithm gets

Term Meaning Example

Statement / Data

Correct Data

Incorrect Data

Determining Output

Example: Test Total Price Algorithm
Algorithm: 
 Add prices of mouse (500), keyboard (1200), watch (800).

Numbers, text, prices

Age = 12, Name = "Ali"

Age = -5, Name = "" (empty)

See if total price = 2800

Normal inputs it should
 handle

Input Type Test Data Expected Output Result

Correct

Incorrect

500, 1200, 800 2800 ✅ Pass

-100, 1200, 800 Should show error
✅ Pass 

(if handles error)

Wrong or extreme inputs

Follow each step with input
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EXERCISE

Terms to Remember
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Class Activity

102



Unit 3: Algorithmic Thinking and Problem Solving

103

Instructions for Teachers

· Teacher must start lecture with real-life examples to explain concept of an 
algorithm

· Teachers must turn algorithm writing into game by arranging class activities such 
as “making a student as robot” and then give step-by-step instructions to move a 
classmate (robot) from point A to B. 

· Teacher must introduce concept of flowcharts alongside algorithms to visualize 
logic.

· Teacher must use color-coded shapes to explain the purpose of different shapes 
used for designing flowcharts.

· Teacher must teach each skill of computational thinking as a life skill, not just a 
coding skill by connecting it with real-life examples.

· Teacher must give students incorrect algorithms and ask them why it produces 
wrong results and how to fix it.

· Teacher must also encourage group thinking by asking them to write their own 
algorithm and then do testing of each other's work.

· Teacher must create worksheets that should include various tasks such as fill in 
the blanks, true/false, match given steps with tasks, etc.

· Teacher must arrange hands-on activities in class by giving students problems 
that they can solve using logical reasoning such as puzzles or games.

103
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Instructions for Teachers
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PROGRAMMINGPROGRAMMINGPROGRAMMING

105

Chapter 444

After the completion of this unit students will be able to:

Student Learning Outcomes:

 

 Understand Information Representation System
Binary and Decimal Number System
Differentiate between binary and decimal number system
Convert decimal to binary and vice versa.
Understand Encoding and Decoding Text in Binary using ASCII
Encode and Decode Image in Binary
Apply Fundamental programming concept.
Create multi sprite and multi script program using visual programming tool.
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Your Data Computer Data

Number System

Decimal
Number

Binary
Number

Octal
Number

Hexadecimal
Number

Base 10
(0-9)

Base 2
(0-1)

Base 8
(0-7)

Base 16
(0-9, A-F)
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First remainder

Second remainder

Third remainder

Fourth remainder

Fifth remainder

Read up

Binary Number = 11001

2
2

2

2

15
7

3

1

0

1
1

1

1

Remainder

Dividend

Binary

Decimal - 15

Binary - 1111

2

2

2

2

25

12

6

3

1

0

2

1

0

0

1

1
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2
2

2

2

31
15

7

3

1

1
1

1

1

(31)  = (11111)10 2

Activity Time
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Activity Time
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ASCII - Binary Character Table

Letter ASCII Code Binary Letter ASCII Code Binary

a

b
c

d
e

f
g

h

j

k

l
m

n

o

p

q

r

s

t

u

v

w

x
y

z

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

Q

R

S

T

U

V

W

X

Y

Z

097

098

099

100

101

102

103

104

105

106

107

108

109

110

111

112

113

114

115

116

117

118

119

120

121

122

065

066

067

068

069

070

071

072

073

074

075

076

077

078

079

080

081

082

083

084

085

086

087

089

090

088

01100001

01100010

01100011

01100100

01100101

01100110

01100111

01101000

01101001

01101010

01101011

01101100

01101101

01101110

01101111

01110000

01110001

01110010

01110011

01110100

01110101

01110110

01110111

01111000

01111001

01111010

01000001

01000010

01000011

01000100

01000101

01000110

01000111

01001000

01001001

01001010

01001011

01001100

01001101

01001110

01001111

01010000

01010001

01010010

01010011

01010100

01010101

01010110

01010111

01011000

01011001

01011010
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Encoding an Image in Binary
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Motion Looks Sound Events Control Sensing Operators Variables My Blocks
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Code Palette

Script Area

Stage Area

Sprite Info Area

when clicked when space key pressed when this sprite clicked

when backdrop switches to backdrop1 when loudness > 10 when I receive message 1
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Activity Time

A Sprite in Scratch is an object or character 
that performs actions in a project.

when clicked

when space key pressed

when this sprite clicked

when clicked

go to x: 0 y: 0

glide secs to x: y:1 0 0
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when clicked

go to x: y: 00

1 20 30glide secs to x: y:

clicked

go to x: y:0 0

forever

move steps10

when
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Go to Motion block and use block                        in forever loop to check 
position of sprite. If Sprite reaches to wall if on edge, bounce block will return 
back sprite and changes its position upside down.

when clicked

go to x: y:0 0

forever

move steps10

when clicked

go to x: y:0 0

forever

move steps10

if on edge, bounce

if on edge, bounce
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Activity Time

Allow a user to move a sprite (flying cat             , Parrot         ) using arrow keys or 
make sprite move automatically in all over screen without user intervention when 

program start.

when clicked

go to x: y:0 0

forever

move steps10

if on edge, bounce

set rotation style left-right

set rotation style left-right

Y

X

-200 -200
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Teacher 
demonstrates 
to  students 
how choose 

different 
sprites and 

changes 
costumes.

Sprite

Show

Egg2

Size Direction100

18 -43X y

90

Chick Egg Egg2

Choose a Sprite

X y 0Sprite Sprite1

Show Size 100 Direction 90

0
Stage

Stage

Backdrops

B s

Chick Egg Egg2

Choose a Backdrop

Variables

Variables

Make a Variable

Finish

Score

Timer
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when clicked

go to x: y:-180 -120

set Score to 0

set

set

Timer

Finish

to

to

0

repeat until

wait

60Timer

30 seconds

change Timer by 1

Finishset to finish

say Time is Over!

think join Your Score is Score for 2 seconds

stop all

1

2

3

4

5

6

7

8



Unit 4: Programming

121

when clicked

go to x: y:-180 -120

set to

set

set

Timer

Finish

to

to

0

repeat until 60Timer

wait 1 seconds

Finishset finish

say Time is Over!

think join Your Score is Score for 2 seconds

stop all

change Timer by 1

to

Score

Timer

Score

Finish

1

0

Sprite

Chick Egg

Chick -180 -120
Stage

x y

Show Size 100 Direction 90

Backdrops

2

Timer

Score

Finish

0

0

=
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1

2

3

4

5

6

7

when space key pressed

if Finish finish then

think join Game Over! Your Score is Score for seconds2

stop this script

else

start sound Chirp

repeat 10

10change y by

repeat 10

-10change y by

change Score by 1

=

when clicked

go to x: y:-180 -120

set Score to 0

0toset Timer

set Finish to

Timer 60=repeat until

wait 1 seconds

change Timer by 1

set Finish to finish

say Time is Over!

think join Your Score is Score for 2 seconds

stop all

when space key pressed

if Finish = finish then

think join Game Over! Your Score is Score for 2 seconds

stop all

else

start sound Chirp

repeat 10

change y by 10

10repeat

change y by -10

change Score by 1
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when clicked

hide

wait seconds1

show

forever

go to x: y:240 -145

3 -240 -145glide secs to x: y:

when clicked

switch costume to egg-a

switch costume to egg-b

wait until touching Chick

set Finish to finish

stop all

?

Sprite

Chick Egg

Chick -180 -120
Stage

x y

Show Size 100 Direction 90

Backdrops

2

Timer

Score

Finish

1

0

Timer

Score

Finish

1

13

finish

Game Over! Your Score
is 13
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when clicked

hide

wait seconds1

show

forever

go to x: y:240 -145

3 -240 -145glide secs to x: y:

when clicked

switch costume to egg-a

switch costume to egg-b

wait until touching Chick

set Finish to finish

stop all

?
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Summary

EXERCISE

move 10 steps
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Class Activity

Instructions 
for Teachers

1. Create a Countdown timer.
2. Award player a score point under certain conditions, such as if they can touch 

another sprite that is automatically moving, or if player clicks on a moving sprite.

move 10 steps

when clicked

go to x: y:0 0

repeat until x position > -10

move steps10

stop all

stop all
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DIGITAL DIGITAL 
CITIZENSHIPCITIZENSHIP

DIGITAL 
CITIZENSHIP
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Chapter 555

After the completion of this unit students will be able to:

Student Learning Outcomes:

 

 Identify appropriate and inappropriate behavior while using the digital 
environment. 
Describe Cyber Bullying
Describe the importance of netiquettes, being safe, responsible, and respectful 
while being online.
Discuss issues of bias on digital platform.
List improper use of computer resources. 
Describe threats and ways of actively protecting devices and networks from 
viruses, intrusion, vandalism, and other malicious activities.
Discuss positive and negative impacts of using social media, both online and 
offline.
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You’re stupid!
I hate you!

You are a looser! You’re stupid!

I hate you!

You are a looser!

Hassan feels very sad;
he may lose his 
self-confidence
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Look what [Name]
said to me
privately

When  someone  keeps  wa tch ing , 
messaging, or following another person 
online in a way that feels scary or makes 
them uncomfortable. For example a girl 
keeps checking her classmate's posts, 
sends messages every day, and follows her 
in all online games, even after being asked 
to stop.
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Tell a Trusted Adult
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 Netiquette is a combination of the 
words "network" and "etiquette." It means 
showing courtesy and politeness when 
communicating and interacting with 
others while using the Internet and social 
media apps like WhatsApp, Facebook, 
Instagram, Snapchat, Twitter(x) and 
TikTok.

Figure 5.13: An illustration of 
importance of netiquettes

It helps to stay kind and respectful, 
even when chatting or posting 
online.
It reminds one to think before 
typing to avoid accidentally 
hurting someone's feelings.

It teaches to respect each other's personal information and privacy.
It helps to make good friends online and enjoy safe, fun experiences.
It teaches healthy mental habits and helps one stay smart when using the Internet 
in the right way.

While using apps like WhatsApp, Facebook, TikTok, 
Snapchat, Instagram, YouTube, and Twitter (X), one 
should always keep personal information private. 
This helps to be safe from strangers and bad things 
online. Below are the tips to follow to stay safe.

Never share full name, home address, phone 
number, or school name with strangers. 
Use a strong password to keep account safe, 
for example password: 2014@12Sun! 
If someone is being mean or sending weird 
messages, block and report it to a trusted 
adult. 
Keeping safe online is just as important as 
staying safe on the playground.

Figure 5.14: An illustration of 
keep information safe with 

strong password.

Thank
you
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Think 
before 
Posting
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On X (Twitter), a message may 
blame someone without proof.

X (Twitter)

Instagram

On Instagram, someone may 
post only happy moments and 

hide sad ones.

Facebook

On facebook, a post may 
support one person in a fight 

without showing the full story.

Channels

News channels may talk only 
about one side of an event.
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i) Using someone else's login without permission: 
  Illegal logging in with a friend's ID or password.
ii) Playing games during class time: 
 Downloading games or tools that teacher or school did not allow.
iii) Installing or changing someone else's work: 
 Removing a classmate's project from a shared folder.
iv) Deleting or changing someone else's work: 
 Removing a classmate's project from a shared folder.
v) Sharing personal or private information: 
 Posting someone's address or phone number on social media.
vi) Copying rude or mean messages: 
 Writing hurtful comments in a group chat or on school forums.
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Tip for Offline
Offline means things that user does in real life, not on the Internet.
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Summary

· Digital Environment: The online world you enter when you use a computer, 
phone, or tablet to connect to the internet.

· Appropriate Online Behavior: Be kind, respect friends' privacy, use strong 
passwords, and tell an adult if something wrong is seen.

· Inappropriate Online Behavior: Do not bully people, share private 
information, talk to strangers, or click on strange links.

· Cyber bullying: Using technology to hurt, embarrass, or scare someone again 
and again.

· Dealing with cyber bulling: Tell a trusted adult, do not reply to the bully, block 
them, and save the evidence.

· Netiquette: The rules for being polite and respectful online.
· Harassment: Repeatedly sending mean, insulting, or threatening messages to 

someone online.
· Impersonation: Pretending to be someone else online by using their name or 

photos to post rude or hurtful things.
· Outing: Sharing someone's private or embarrassing information online without 

their permission.
· Exclusion: Intentionally leaving someone out of an online group, chat, or 

activity to make them feel hurt and alone.
· Cyberstalking: Repeatedly watching, messaging, or following someone online 

in a way that makes them feel scared or uncomfortable.
· Bias: When information online is unfair and only shows one side of a story.
· Computer Threat: A computer threat is anything that can harm a computer, 

network, or the information stored in them. It can cause damage, steal private 
information, or stop the computer from working properly 

· Phishing: When someone sends a fake message to trick you into sharing your 
password or personal information.

· Hacking: When someone gets into your computer or online accounts without 
permission.

· Malware: A harmful program that can damage user computer.
· Virus: A bad program that can copy itself and spread, deleting or damaging files.
· Spam: Unwanted, junk messages or emails, often sent to many people at once, 

usually containing ads or bad links.
· Ransomware: A type of malicious software that locks your computer files and 

demands money to unlock them.
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EXERCISE



Unit 5: Digital Citizenship

143

Class Activity 1
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Class Activity 2

Instructions for Teachers
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Chapter 666

After the completion of this unit students will be able to:

Student Learning Outcomes:

 

 List steps of design thinking process.
Identify use and benefits of design thinking for entrepreneurs
Describe how innovation has changed the entrepreneurial mindset.
Discuss benefits to an innovation process of each design thinking step. 
Explain a project through the design thinking process.
Understand sustainable development goals in the context of world problems 
facing that need to be solved. 
Share examples of problems faced that could be solved by a product or a service.
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A customer is a person that buys product or services from a company.
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Empathize Ideate Test 

Identify Define Prototype Reflect Implement

Iterate/ 
Repeat as needed
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 Design thinking helps entrepreneurs understand problems deeply, generate 
creative ideas, collaborate effectively, and test possible solutions quickly. Below are some 
key benefits:

It helps people clearly understand the real problem before trying to fix it.

It encourages people to think of new and smart ideas to solve problems in better 
ways.

It promotes teamwork, idea sharing, and learning from one another.

It ensures that solutions truly match what people need and want.

It allows rapid exploration and testing of ideas to find what works best.

It enables people to learn from what didn't work and improve their ideas.

It helps avoid wasting time and money by addressing the right problem in the 
right way.
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Think about 
Real-life 
Problems

Start by thinking: 
“What problem can I 

solve to help people?”

Try to Help 
Others

Good ideas often 
come from thinking 

how to make life 
easier or better.

Learn from 
Business People

Ask successful people 
about their ideas and 

how they started.

Check Social 
Media or TV 

Trends
See what is popular 
and what people are 

talking about.

Ask People they 
Need (Survey)

Talk to family, 
teachers, or friends. 
Find out what they 

wish they had.

Look Around and 
Observe

Watch carefully at 
school, home, or 

outside to find things 
that can be improved.

Mix Old Ideas to 
Make a New One
Combine two things to 

create something 
useful and fun.

Read Books or 
Watch Videos
Learn about cool 
inventions and 

creative ideas from 
around the world.

1 2

3 4

5 6

7 8
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Identify the Problem

Test and Reflect

Empathize

Ideate

Prototype Implementation

Define a Problem

My_unique_arts

How can we make 
unique gifts for 
our friends?
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1
No 

Proverty
Zero

Hunger
Good Health

and Well-Being
Quality

Education
Gender
Equality

Clean Water
and Sanitation

2 3 4 5 6

Affordable and
Clean Energy

Decent Work and
Economic Growth

Industry, 
Innovation and 
Infrastructure

Reduced
Inequalities

Sustainable 
Cities and 

Communities

Responsible 
Consumption

and Production 

8 9 10 11 127

Climate
Action

Life
Below Water

Life
On Land

Peace, Justice
and Strong
Institutions

Partnerships
for the Goals

14 15 16 1713
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Terms to Remember

Summary
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EXERCISE
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Instructions for Teachers
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